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To help you better track the full breadth of G Suite launches, including those that aren’t announced on the ​G 
Suite Updates blog​, check out the ​What’s new in G Suite​ page in the Help Center. 
 

We’d really appreciate ​your thoughts​ on how we can make this resource work best for you. 
 
- The G Suite Team, April 1, 2019 

 

https://gsuiteupdates.googleblog.com/
https://gsuiteupdates.googleblog.com/
https://support.google.com/a/go/whatsnew
https://docs.google.com/a/google.com/forms/d/19AJmnJuG_JWdOTSf0B_kL1DFemE8bbkJbZ42Iz6uDx0/viewform


 

 
Dynamic email in Gmail (beta) 

 

  Announced March 26th, 2019                         Admin feature                                                          - ​back to top​ - 

 
What’s changing 
We’re opening a beta program for dynamic email in Gmail. Dynamic email allows email senders to embed AMP 
into messages themselves, making them more actionable and updating them with the most current 
information. 
 
Who’s impacted 
Admins and end users 
 
Why you’d use it 
Dynamic emails make emails more useful and interactive in Gmail. Your emails can stay up to date so you’re 
always seeing the freshest information, like seeing the latest comment threads from Docs, or taking actions, 
like filling out forms, or replying to comments inline directly from within the message itself. 
 

 
 
How to get started 

ǒ Admins: Dynamic email in Gmail Beta is available as an opt-in to all G Suite customers. Admins can 
opt-in to the beta by going to the Admin console and navigating to ​Apps > G Suite > Settings for Gmail > 
User settings.​ Here they will be able to select the option to Enable dynamic email. 

ǒ End users: Once dynamic email is activated in the Admin console, users will begin seeing dynamic 
emails from senders who have adopted AMP for Email. 

 

 
 
Additional details 
This feature is currently only available in Gmail on the web, with mobile coming soon. Email senders who wish 
to send dynamic emails must register with Google before their messages appear for end users. Check out the 
Help Center for more information on ​how dynamic email works with Vault​. 
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https://docs.google.com/document/d/1BwvhQT5N46NoKQ_xvWh4TbxS3kVP9Rj7iHL_WxL7AF4/edit#bookmark=kix.bktnw9g6q8ws
https://support.google.com/vault/answer/6127699#mail-attachments


 

 

 
Work together 

View Calendar event creators to easily swap meeting rooms 

  Announced on March 18th, 2019                          Share with your organization                                               - ​back to top​ - 

 
Quick launch summary 
You can now see the creator of a meeting when looking at a “busy” block of time on a resource or room’s 
schedule in the “Find a time” grid view. Simply hover over the block to see the event creator’s name (even if 
the event is “Private.”) 
 

 
 
We’ve heard from you that being able to see who booked a room for a meeting is crucial in order to easily 
reach out to the creator to ask if they would be open to swap the room or change the meeting time. 
 
Please note, the information such as the description and title of the event will still be hidden to ensure no 
sensitive information is shared. 
 

Delegate App Maker admin privileges to users 

  Announced on March 4th, 2019                          Admin feature                                                                                     - ​back to top​ - 

 
What’s changing  
We’re making it possible for G Suite super admins to delegate access to the App Maker projects report to 
other users. Among other things, this will allow appropriate employees without super admin privileges to track 
App Maker projects and for customers to delegate access to their reseller partners. 
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Who’s impacted 
Admins and end users. 
 
Why you’d use it 
We ​launched App Maker​ to general availability in June 2018, so teams can easily build custom apps that 
speed up their workflows and improve their processes. As part of that launch, we gave G Suite admins access 
to the ​App Maker projects report​, which includes a list of all App Maker projects in their organization and 
details for each app. 
 
We hope that this launch will make it easier to use and manage App Maker projects in your organization. 
 
How to get started 

ǒ Admins: To enable this feature, check both the App Maker > Settings checkbox and the App Maker > 
App Maker Projects Report checkbox. You may want to create a custom role to facilitate setting or 
unsetting both of these privileges. Visit the Help Center for detailed i​nstructions on how to create a 
custom administrator role​. 

ǒ End users: No action needed. 
 

 

Launching new Google Drive / Microsoft Outlook integration, shutting down 
legacy plugin 

  Announced on March 27th, 2019                          Share with your organization                                               - ​back to top​ - 

 
What’s Changing 
We’re updating ​Drive File Stream​ to replace the functionality of the “​Google Drive plug-in for Microsoft Office.​” 
As a result, the outdated plugin will be shut down on June 26, 2019. This only impacts users of the Google 
Drive plug-in for Microsoft Office. Those users will notice two key changes: 
 

1. New Drive / Outlook integration:​ The update to Drive File Stream will include a plugin to manage 
Google Drive files from Microsoft Outlook. This will make it easier for users to use Google Drive 
without leaving the Outlook interface.  
 

2. New process to save to, or open from Drive:​ Drive File Stream users can save and open Drive files 
through the regular menu, rather than using the Google Drive plug-in for Microsoft Office interface.  

ƺ To save to Drive, use ​File > Save​, then choose a destination in Drive File Stream.  
ƺ To open from Drive, Open through the ​File > Open ​menu and find the file you want.  
ƺ If your organization uses the Google Drive plug-in for Microsoft Office, you should make sure 

your users are using the latest version of Drive File Stream before June 26, 2019 to ensure 
continued access to this functionality. 

 
The new plugin will bring Drive to the Outlook interface  
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https://gsuiteupdates.googleblog.com/2018/06/build-apps-your-business-needs-with-app-maker.html
https://support.google.com/a/answer/7648248
https://support.google.com/a/answer/2406043
https://support.google.com/a/answer/2406043
https://support.google.com/drive/answer/7329379
https://tools.google.com/dlpage/driveforoffice


 

 

Who’s impacted  
Admins and end users 
 
Why you’d use it  
Drive File Stream​ offers an easy way to integrate Microsoft Office and Google Drive. The latest versions (30.1 
and up) will include the new Outlook plugin that will make it easier for users to: 
 

ǒ Save attachments from Outlook to Drive  
ǒ Attach Drive files to Outlook messages  
ǒ Ensure recipients always have access to Drive links sent in Outlook emails  

 
Drive File Stream already makes it easy to save to the local Drive File Stream folder through the regular “Save” 
menu. 
 
By ensuring your users are using the new plugin before June 26, 2019, there will be little to no disruption to 
their workflows. 
 
How to get started  

ǒ Admins: Make sure your users are using an up to date version of Drive File Stream. Use our Help 
Center to learn how to ​deploy Drive File Stream for your organization​.  

ǒ End users: Ensure you’re using an up to date version of Drive File Stream. Use our Help Center to 
download and install Drive File Stream on your computer​.  

 
Additional details  
Users of the Drive for Office plugin will see an in-product notification, pictured below, starting on March 27, 
2019. This will encourage them to update to the new plugin to continue using Drive from Outlook. 
 

 
 
 
 
 
 

Simultaneously present and be seen with Hangouts Meet 

  Announced on March 12th, 2019                          Share with your organization                                               - ​back to top​ - 

 
Quick launch summary 
Now, when you present your screen in a Hangouts Meet meeting, your camera’s video feed will remain visible. 
This allows other meeting participants to continue to see you while you present. 
 
 
 
 
 
 
 
 
 
 
 
 

Recurring Calendar meetings will migrate to Hangouts Meet video calling 

Ą 

https://support.google.com/drive/answer/7329379
https://support.google.com/a/answer/7491144
https://support.google.com/drive/answer/7329379


 

  Announced on March 11th, 2019                          Share with your organization                                               - ​back to top​ - 

 
What's changing 
As part of the migration from classic Hangouts to Hangouts Meet that ​we announced​ last year, we’ll now 
begin migrating the video conferencing for your recurring Calendar events from classic Hangouts to Meet. 
Previously, we made the change so that new events scheduled in Calendar will use Meet. Now this change is 
to update previously scheduled events in Calendar as well. 
 
Who’s impacted 
End users 
 
Why we’re migrating 
We've built Hangouts Meet to have a fast, simple interface with enterprise grade meeting functionality such 
as ​livestreaming​ and ​meeting with up to 100 people​. To ensure you get the best-in-class experience we’re 
migrating the remainder of your existing recurring Calendar events. This will happen gradually in an effort to 
limit any disruption and ensure that you can focus on what’s important: meetings where people can be as 
productive as they are when they’re face-to-face. 
 
How to get started 

ǒ Admins: No action needed. 
ǒ End users: When you join a recurring Calendar event on classic Hangouts, you will see a banner that 

future occurrences of this meeting will be on Meet. 
 

 
 
Additional details 
 
Migrating existing Calendar events 
This change will take place gradually as users join affected meetings. They will see a migration banner 
notifying them future occurrences will be on Meet. After the end of the call, all participants will get an updated 
event information with the new meeting details. Single instance (non-recurring) Calendar events will remain 
unchanged. 
 
If your meeting doesn’t migrate 
Some of your meetings may not automatically update to Meet. When this happens, you’ll see a banner in the 
video call notifying end users to ​update the Calendar event to Meet​. This may happen for complex Calendar 
event setups, such as if different events have the same video link. 
 
 
 
 

Delete your conversation history in Hangouts Chat 
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https://gsuiteupdates.googleblog.com/2018/05/migrating-all-g-suite-domains-from.html
https://gsuiteupdates.googleblog.com/2018/09/live-stream-hangouts-meet-meetings.html
https://gsuiteupdates.googleblog.com/2018/11/host-hangouts-meet-meetings-with-up-to-100-people.html
https://support.google.com/a/answer/7686165?hl=en&ref_topic=7302982#calendar


 

  Announced on March 11th, 2019                          Share with your organization                                               - ​back to top​ - 

 
  Quick launch summary 
 
You’ll now be able to delete your conversation history of 1:1 direct messages in Hangouts Chat. These 
deletions apply to 1:1 conversations between classic Hangouts and Hangouts Chat in both directions. Please 
note, you’re only deleting your copy of the conversation history. Other users will still be able to see the chat. 
 

Minor updates related to the Activity Dashboard in Editors and the Admin 
console 

  Announced on March 19th, 2019                          Share with your organization                                               - ​back to top​ - 

 
Quick launch summary  
We’re making two minor updates to verbiage found in the Activity Dashboard in Editors and related settings 
within the Admin console. As we launch more features to the Activity Dashboard, these updates will help keep 
things clear for both admins and end users. 
 
In the Admin console:  
In the Activity dashboard settings, where it previously read “Access to activity dashboard” on the left hand 
navigation, it will now read “Access to view history.” 
 

 
  
From here, Admins can set the ability for users to access Viewers and Viewer trend activity in the dashboard 
to ON/OFF. To learn more about file activity visibility, see this article in the ​Help Center​. 
 
In Editors:  
Within the Activity dashboard, the “View time” tab has been renamed to “Viewers.” From this tab, document 
owners can see the last time users with Edit access viewed the file and take action to follow-up. To learn 
more about view history in Docs, Sheets, and Slides, see ​this Help Center article​.  
 
We’re also changing the icon for the Viewers tab — previously it was a clock, now it will be a person. This 
change is to better indicate the purpose of this tab, which is viewer history, not time viewers spent in the 
document. 
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https://support.google.com/a/answer/7573825?hl=en
https://support.google.com/docs/answer/7378739


 

Simple to use  
Work smarter with the new Priority page in Drive 

  Announced on March 18th, 2019     Share with your organization                                - ​back to top​ - 

 
Quick launch summary  
We’re launching a new Priority page in Drive as a new way to help you stay focused and get work done. This 
page will help you access the files you need through a combination of suggestions and workspaces. With the 
new Priority page, not only are the most relevant files served up to you, but you can take action on them, as 
well as sort them into workspaces. 
 
We hope this makes accessing your most important files easier and helps you work more efficiently.  
You can access the Priority page from the left-hand navigation panel in Drive. Some features you’ll see on the 
Priority page include: 
 
Priority:  

ǒ Here you’ll see the documents we think are most relevant to you right now. These 
machine-learning-powered suggestions are based on various signals from your activity. On each 
suggested document, you can also take actions in line, without navigating to the doc in question, like 
replying to a comment or reviewing recent edits. 

 
Workspaces:  

ǒ In Workspaces, you’ll be able to see intelligent suggestions of related content to group together for 
easier access— like multiple files related to the same project.  

ǒ You can also create your own personalized Workspaces collecting any files you have access to, 
including content stored in your My Drive and various Team Drives.  

ƺ Right-click on any file and select Add to Workspace to dynamically group files as you work. 
 
If users would like to make Priority their default home page, they can do so in their settings, which is 
accessible via the gear icon in the upper righthand corner. 
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New Drive file suggestions in Chrome launching in beta 

  Announced on March 20th, 2019     Admin feature                                                          - ​back to top​ - 

 
Quick launch summary  
We’re launching a beta program for a new feature that allows users to search for Google Drive files that they 
have access to when using the Chrome Omnibox (search/URL box). Users in the beta can now search for files 
in Drive by owner or type, where previously they could only search for a title or URL of a webpage. This feature 
is similar to what users see when searching for files in Google Drive. 
 
Admins for G Suite Business, Enterprise, and Enterprise for Education ​can learn more and apply for the beta 
here​. 

 
 
Who’s impacted  
Admins only 
 
Why you’d use it  
This feature will give users faster access to the files and data they need while searching in Google Chrome. 
Users will now be able to see Google Docs, Sheets, Slides, PDFs, and other file type suggestions from both “My 
Drive” and “Shared with Me” when searching in Chrome browser. This will help people get work done faster. 
 
How to get started  

ǒ Admins: For more details and to apply for the beta, ​see this form​.  
ǒ End Users: No action required.  

 
Additional details  
This feature will be available to users signed into a Chrome profile on any operating system: Chromebook, 
Mac, Windows, etc. 
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https://docs.google.com/document/d/1BwvhQT5N46NoKQ_xvWh4TbxS3kVP9Rj7iHL_WxL7AF4/edit#bookmark=kix.bktnw9g6q8ws
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https://docs.google.com/forms/d/e/1FAIpQLSdCV4fxiKIaqi6Np5p8KBq4yABY_gRyNYVJ6mJd9X3YHKwbag/viewform
https://docs.google.com/forms/d/e/1FAIpQLSdCV4fxiKIaqi6Np5p8KBq4yABY_gRyNYVJ6mJd9X3YHKwbag/viewform


 

Threading changes in Gmail conversation view 

  Announced on March 29th, 2019     Share with your organization                                - ​back to top​ - 

 
What’s changing 
We are launching some changes to how Gmail threads messages when you have conversation view turned on. 
Previously, Gmail would thread together messages when either of the two conditions below are true: 
 

1. A message is sent in reply to another 
2. A message has: 

a. The same sender or recipients, 
b. The same subject, 
c. And is sent within one week of an earlier message in the thread. 

 
With this change, we’re adding the requirement that an incoming message’s Reference header, if present, must 
reference IDs of previous messages in order to thread (see image below for example). This means that if you 
receive two emails with the same subject from the same sender, these emails will not be threaded together 
unless one explicitly references the other. 
 

 
 
Who’s impacted 
End users 
 
Why you’d use it 
This change helps to make sure that messages are only threaded when there is a definite relationship between 
them. 
 
How to get started 

ǒ Admins: No action required. 
ǒ End users: No action required. You’ll see these changes roll out on Gmail on the web and on mobile 

apps. 
 
Additional details 
If you are managing a system that sends email notifications to users and want your emails to be threaded in 
Gmail conversation view, then you have to ensure that your notifications: 
 

ǒ Have the same subject 
ǒ Have reference headers that reference IDs seen earlier in the thread, or have references headers that 

consistently refer to the same message ID 
 
Additionally, if you don’t want your messages to be threaded in Gmail, you can either have different subjects or 
send each message with a unique References header value that will never match another message. 
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Take action faster with customizable swipe actions in Gmail on iOS 

  Announced on March 28th, 2019     Share with your organization                                - ​back to top​ - 

 
Quick launch summary 
You can now set up swipe actions in Gmail on iOS to do any of the following actions: Archive, Trash, Mark as 
read/unread, Snooze, and Move to. 
 
We recently announced a brand new mobile redesign for Gmail with many new productivity improvements.To 
help you get things done even more quickly, you can now customize the actions you can take when swiping on 
an email in Gmail on your iOS device. 
 
You can access the swipe configuration settings by going into the Gmail iOS app and navigating to ​Settings > 
Swipe ​actions, and choosing the swipe options that work best for you. 
 

 
 
In addition to using swipe actions to quickly triage your email, you can also use the same actions to triage your 
notifications as well. For example, if you like to snooze emails, you can press firmly (3D Touch) or long press 
on a Gmail iOS notification, and click on "Snooze" directly to pick the date and time when to snooze the email 
until. 
 
 

It’s now easier to insert images in cells in Google Sheets 

  Announced on March 19th, 2019     Share with your organization                                - ​back to top​ - 

 
What’s changing   
We’ve made it simpler to add images inside of cells in Google Sheets. Previously, it was only possible to insert 
publicly hosted images into a cell using the IMAGE function. 
 
Now, you can insert any image, like those saved on your desktop or mobile device, into a cell by using the 
IMAGE function or the new option found inside the Insert menu. 
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Who’s impacted  
End users 
 
Why you’d use it  
You’ve told us this feature would be helpful for many tasks like:  

ǒ Adding receipts to expense-tracking spreadsheets  
ǒ Adding icons to icon libraries  
ǒ Adding logos to better brand your resources  
ǒ Adding product images to inventory lists, and more.  

 
How to get started  

ǒ Admins: No action needed.  
ǒ End users: You can add images directly to cells in two ways on Desktop:  

ƺ Use the IMAGE() function  
ƺ Via the menu bar at the top of a Sheet: I​nsert > Image > Image in cell  

ƴ Select image from Drive or upload one.  
 

 
 

ǒ On Mobile:  
ƺ Tap once on a cell to select  
ƺ Tap again to bring up menu: ​Insert > Tap the “+” at the top of the screen > Image > Image in cell  
ƺ Select an image from the options presented to you.  

 
Additional details  
You can have multiple cells containing an image in a Sheet, but note that only one image per cell is possible at 
the moment.  
 
Images inside cells will be associated with a row and move along with the data—so, if you move rows, filter or 
sort them, the images will move with the content in the row, unlike previously when images would sit on top of 
the grid.  
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Using the formatting and alignment tools, you can pin the image to a specific corner of the cell or set the 
alignment how you’d like. By default, images will align to the bottom left corner of the cell. 
 
 
 

Set start times and import reminders in Tasks 

  Announced on March 18th, 2019     Share with your organization                                - ​back to top​ - 

 
What’s changing 
We’re adding three highly-requested features to Tasks. You can now: 

ǒ Set a date and time for your tasks and receive notifications 
ǒ Create repeating tasks 
ǒ Import reminders into Tasks 

 
Who’s impacted 
End users 
 
Why you’d use it 
We’ve heard from you that you’d like Tasks to be the one destination to track what you need to do in G Suite. 
These features will help make sure all of your to-dos are in Tasks, and ensure that you can keep track of the 
deadlines associated with them. Additionally, importing reminders to Tasks can help your users if your 
organization is currently ​transitioning from Inbox to Gmail​. 
 
How to get started 

ǒ Admins: No action needed 
ǒ End users - Date/time and repeating tasks: 

ƺ When you create or edit a task, you’ll now see a new “Add date/time” field. 
ƺ After clicking on Add date/time, you can enter the date, time, and recurrence of this task. 

 

 
 

ǒ End users - Import to tasks: 
ƺ When you open Tasks on the web or your mobile app, you’ll see a prompt to copy your existing 

reminders over to Tasks. You can also trigger this manually by opening the overflow menu in 
the top right. 

ƺ You’ll be able to select which list in Tasks you’d like to add them to, or create a new list. 
ƺ You can also indicate whether or not you’d like these reminders to be deleted once they are 

copied. 
 
Additional details 
 
New time features 
Every task now has two time-based properties, date and start time, that are available in the edit screen of each 
task. 
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These tasks will then show up in Google Calendar on the web at their specific time, as long as you have the 
“Tasks” calendar enabled on the left-hand side. If you’ve enabled mobile notifications, you'll also get notified 
for tasks at their scheduled dates and times in the Tasks mobile apps (​Android​/​iOS​). For tasks that have a 
date, but don’t have a time, you’ll get notifications at 9am local time. 
 
If a task wasn’t marked as completed, you’ll get a second notification at 9am the day after a task was due. 
 
Importing reminders into Tasks 
 
This import tool will pull your reminders (from Inbox/Gmail, Calendar, or the Assistant) into Tasks. 
 
When importing reminders into Tasks, we’ll copy over the title, date, time and recurrence of the reminder. 
Please note, reminders with locations associated will not be imported. Additionally, this is a one-time import 
and not a constant sync. 
 
 
 

Google Calendar automatic room suggestions available on mobile 

  Announced on February 13th, 2019     Share with your organization                                - ​back to top​ - 

 
Quick launch summary  
Last year, we released automatic room suggestions in Google Calendar on the web. We’re now bringing that 
feature to Android and iOS devices. 
 
This feature, using Google AI, suggests the rooms for your meetings based on the locations and preferences of 
the guests. 
 
To enable this feature, structured resource information and users’ work locations are required to be set. 
 

 
 
 

 

 

 

Āă 

https://play.google.com/store/apps/details?id=com.google.android.apps.tasks
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Google Drive is getting a new look on iOS and Android 

  Announced on March 12th, 2019     Share with your organization                                - ​back to top​ - 

 
What’s Changing 
Google Drive is getting a new look and feel on iOS and Android, making it easier to communicate and 
collaborate across files in Drive on mobile devices. 
 

 
 
This Material redesign is part of a larger effort to bring the look and feel of our G Suite apps together as a 
whole, with ease-of-use in mind. 
 
Some improvements you’ll see include: 
 

ǒ New Home tab and bottom navigation  
ƺ Similar to ​Drive on the web​, the Home tab will surface the files that are most important to you, 

based on things like:  
ƴ The last time you accessed or edited a file  
ƴ Who specific files are frequently shared with  
ƴ What files are used at specific times of day. 

ƺ A more intuitive bottom navigation bar that features options to switch between Home, Starred, 
files shared with you (Shared), and all files (Files), allowing for quicker access to your most 
important items. 
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ǒ Expanded search bar  
ƺ The search bar is now more accessible across the application, including from the Team Drives 

page. 
  

ǒ My Drive, Team Drives and Computers in Files view  
ƺ Team Drives will be now be displayed as a tab next to My Drive in the Files view. Users will 

also see a Computers tab if they have backed up content from a local machine to their 
account. 

 

  
 

ǒ  New account switching experience  
ƺ The feature to switch accounts is moving from the left navigation menu to an icon in the top 

right. 
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ǒ  Revised actions menu  
ƺ A revised actions menu attached to every file and folder emphasizes the most frequently used 

actions at the top. Toggles for starred and offline are now changed to buttons. 
 

 
 
Who’s impacted  
End users 
 
Why you’d use it  
We know that mobile devices are critical to getting work done, whether it’s at our desk, in a meeting, sending 
an email, or collaborating. Drive is not just a way to backup files to the cloud, but a critical way to easily share 
work, make last minute changes to content, or review important content on the go. The Drive Mobile redesign 
aims to make these workflows easier. 
 
How to get started  

ǒ Admins: No action required.  
ǒ End users: You’ll see the new look coming your way soon.  

 
Additional details 

ĀĆ 



iOS users will begin seeing the redesign starting on March 12, 2019. Android users will see the redesign 
starting on March 18, 2019. 
 
To help your users navigate this redesign, see this ​change management guide​ or download this ​PDF​. 
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Business ready 

New 2-Step Verification options for G Suite accounts 

  Announced on March 14th, 2019                         Admin feature                                                          - ​back to top​ - 

 
What's changing 
We’re updating how 2-Step Verification works for G Suite. This will make new 2-Step Verification methods 
available for some devices, and update the 2-Step Verification user interface on mobile and desktop devices.  
 
There are three key impacts: 

ǒ New 2-Step Verification interfaces  
ǒ Different screens on different browsers (Safari, Edge, etc.)  
ǒ Expanded Bluetooth security key support  

 
Who’s impacted  
Admins and end users 
 
Why you’d use it  
We hope that these updates make 2-Step Verification easier to use. 2-Step Verification puts an extra barrier 
between your business and cybercriminals who want to access business data. Turning on 2-Step Verification 
is the single most important thing you can do to make your accounts more secure and protect your business. 
 
How to get started  

ǒ Admins: Use our Help Center to find out ​how to set up 2-Step Verification for your organization​.  
ǒ End users: No action needed.  

 
Additional details  

ǒ New 2-Step Verification interfaces: ​You may see new illustrations, text, and instructions in the images, 
dialogs in the 2-Step Verification flows when using a bluetooth or usb security key. See images below 
for examples of the types of changes. 

ǒ Different screens on different browsers:​ You may see different flows on Chrome, Safari, Firefox, Edge, 
and other browsers. Previously the service provider (Google) was responsible for showing these 
dialogs. Now the web browser is responsible. As a result, the flow may be different on each browser. 

ǒ Expanded Bluetooth security key support: ​Bluetooth keys will start rolling out, and can be enabled with 
a flag on Linux. 

 

 
The new 2-Step Verification screen on Google Chrome browser  
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https://support.google.com/a/answer/175197


 

 
The old 2-Step Verification screen  

 
 
 
 
 

New Hangouts Meet peripheral issue alerts and improved connectivity alerts 

  Announced on March 21st, 2019                         Admin feature                                                          - ​back to top​ - 

 
What's changing 
To provide admins better tools to improve the overall performance of their Hangouts Meet devices, we’ve 
introduced a new set of actionable alerts when issues with peripherals are detected. We’ve also made the 
alerts for detected connectivity/network issues actionable with richer information and direct access to the 
device information page. New information in the alerts include: 
 

ǒ Device name 
ǒ Location 
ǒ Alert id (identical for open and close alerts) 
ǒ Issue type (Connectivity or Peripheral) 
ǒ Issue (Offline, Missing microphone, Missing camera, etc) 
ǒ Issue opened timestamp 
ǒ Issue closed timestamp (if closed) 
ǒ Asset location (from the assigned calendar) 
ǒ Annotated location (if set for the device) 
ǒ Asset id (if set for the device) 
ǒ Serial number 
ǒ Direct link to the device page in Google Admin console 

 
Example alerts — email 
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https://docs.google.com/document/d/1BwvhQT5N46NoKQ_xvWh4TbxS3kVP9Rj7iHL_WxL7AF4/edit#bookmark=kix.bktnw9g6q8ws


Open alert 

 
  

Close alert 

 
  
Example alert — text message 
 

Open alert 

 
 
For text message, alerting is only sent out when an issue is detected, not on close. 
 
Who’s impacted 
Admins only 
 
Why you’d use it 
The improved alerts provide additional information to help admins proactively manage their network and 
devices for improved availability and end-user experience. 
 
How to get started 

ǒ Admins: To enable the Hangouts Meet hardware alerts: 
ƺ In the Admin console, go to Devices > Google meeting room hardware > Settings and policies 
ƺ Select the organization for which you want to change the settings for alerts 
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ƺ Enter contact details — email(s) and/or mobile phone number(s) 
ƺ Select delivery methods for connectivity status alerts and peripheral alerts: Click Save to apply 

the settings 
 

 
 

ǒ End users: No action required 
 
Additional information 
Both alert types are optional and delivery can be enabled individually by email and/or text message (SMS) 
(US/Canada numbers only). The email format is intended for easy integration with automated ticketing 
systems. 
 
 
 
 
 

An updated plan & resources for upcoming changes to Groups settings 

  Announced on March 19th, 2019                         Admin feature                                                          - ​back to top​ - 

 
What's changing 
Based on your feedback following our previous announcement, ​Changes to Google Groups settings starting 
May 6, 2019​, we’re making the following changes: 
 

ǒ Additional improvements to the Groups Settings API to help you plan for and manage the changes 
(see more details below).  

ǒ “Post as the group” will remain a separate setting - it will not be merged as we previously stated.  
ǒ “New member posts are moderated” will remain an option for moderation - it will not be deprecated as 

we previously stated.  
ǒ “Take topics” will be merged into the ​content metadata settings​.  
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https://docs.google.com/document/d/1BwvhQT5N46NoKQ_xvWh4TbxS3kVP9Rj7iHL_WxL7AF4/edit#bookmark=kix.bktnw9g6q8ws
https://gsuiteupdates.googleblog.com/2019/02/changes-to-google-groups-settings.html
https://gsuiteupdates.googleblog.com/2019/02/changes-to-google-groups-settings.html
https://support.google.com/a/answer/9191148#ContentModerator


To help you plan for these changes, we’re also sharing a ​Google Sheet​ which can help identify what the new 
settings will be for a group. In addition, we’re changing the ​rollout schedule​ so the new settings will start to 
take effect in Scheduled Release domains on June 3, four weeks after Rapid Release domains. 
 
Use our Help Center to see ​details of these changes and see how you can prepare for the update​. 
 
Who’s impacted  
Admins and end users 
 
Why you’d use it  
We hope these resources will help you better understand and prepare for the changes to Groups settings. 
 
How to get started  

ǒ Admins: See our previous announcement for background on the changes, and use our updated Help 
Center to see ​details of these changes and see how you can prepare for the update​.  

ǒ Developers: See our Cloud blog post for details of the ​API behavior changes​.  
ǒ End users: Support any group audits as decided by admin.  

 
Additional details  
 
Groups API improvements  
On March 25th, 2019, we’ll be updating the ​Groups Settings API​. These updates align the API with the product 
changes we’re making (outlined in our ​previous announcement​ and this post) and mean it’s easier to use the 
API to prepare. API updates include: 
 

ǒ All settings that are to-be merged will be exposed via the API. This means you can audit your current 
groups via API, and make changes to ensure new settings are inferred as you want them to be.  

ǒ New merged settings will be exposed via the API. This means you can query the new merged settings 
and ensure they are going to be inferred as expected. Note that It will be read-only (i.e. inferred value) 
until launch, at which point it will also support write.  

ǒ New bit for ​custom roles​ exposed. If you use custom roles, API queries may return incorrect values. 
The new bit will highlight if a group uses custom roles for one of the merged settings and so will help 
you identify groups that require manual review.  

ǒ New bit for collaborative inbox exposed. We will expose a new bit that represents whether 
collaborative inbox will be enabled for a group. If you expect your group to have ​collaborative inbox 
functionality (e.g. topic assignment), ensure that this bit is true. You may do this by enabling any of the 
collaborative inbox features. Note that it will be read-only (i.e. inferred value) until launch, at which 
point it will also support write.  

ǒ New bit for who can discover group exposed. We will expose a new bit that represents who the group 
will be visible to. This setting will replace show in group directory. Note that it will be read-only (i.e. 
inferred value) until launch, at which point it will also support write.  

 
See our Cloud blog post for ​more details on these API changes and how to use them​. 
 
“Post as the group” will not be merged into the content moderator setting  
 
Previously we stated that this setting would be merged. However, you told us that it was valuable and we 
should keep it separate, so we’re updating the plans and will not merge it. 
 
“New member posts are moderated” will continue to be supported.  
 
The “New member posts are moderated” setting, exposed in the API as MODERATE_NEW_MEMBERS, will 
continue to be supported as a value for moderation. 
 
“Take topics” will be merged with content metadata  
 
We previously suggested that “Take topics” would remain a standalone setting. However, this will now be 
merged as part of the content metadata settings. 
 
New worksheet to help visualize changes 
We’ve created this Google Sheet which will show you what the new settings will be for any group if you input 
the current settings. This can help you check the settings will be inferred as you want them. 
 
 
 
 

āĂ 

https://updatesblog.page.link/groupsws
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https://cloud.google.com/blog/products/g-suite/upcoming-changes-to-the-google-groups-settings-api


 

Disable SMS or voice codes for 2-Step Verification for more secure accounts 

  Announced on March 14th, 2019                         Admin feature                                                          - ​back to top​ - 

 
What's changing 
We’re adding an option for admins to disable telephony options as ​2-Step Verification​ methods for G Suite 
accounts in their domain. This option will prevent their users from using SMS and voice codes for 2-factor 
authentication. 
 
Who’s impacted  
Admins only 
 
Why you’d use it  
There are many forms of 2-Step Verification—from text (SMS) message codes, to the Google Authenticator 
app, to hardware second factors like security keys. And while any second factor will greatly improve the 
security of your account, we’ve long advocated the use of security keys for those who want the strongest 
account protection. 
 
As awareness of the potential vulnerabilities associated with SMS and voice codes has increased, some 
admins asked us for more control over the ability to use phone-based 2-Step Verification methods within 
organizations. The present release does just that - admins get a policy that can enforce the use of multi-factor 
authentication without permitting SMS and voice verification codes.  
 
This new policy gives admins more control over the security methods used in their domain, and increases the 
security of user accounts and associated data. 
 
How to get started  

ǒ Admins: Apply the new policy by changing the setting at​ Admin console > Security > Advanced security 
settings > Allowed two step verification methods​.  

ǒ End users: No action needed unless admin changes configuration.  
 

 
2-factor authentication options in the G Suite Admin console  

 
Additional details 
 
How users can configure 2-Step Verification once the policy is enforced  
Users with the new policy applied will not be able to add SMS or voice based codes as an option - either when 
enrolling in 2-Step Verification for the first time or later at myaccount.google.com. A user enrolling in 2-Step 
Verification for the first time will see the screen below. This first provides an option to set up Google Prompt, 
as well as ‘Choose another option’ which will let them add a Security Key instead. 
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